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Welcome to the seventeenth edition of my Final Cut Pro newsletter!

The goal of this newsletter is to provide information helpful to the 
professional user of Final Cut Pro. This newsletter publishes 
around the middle of each month. Past issues are not archived, 
however, key articles are posted to my website for your future 
reference. Starting this month, all software references are to Final 
Cut Pro 5 unless otherwise noted. 

Also, please invite your friends to visit my web site -- www.
larryjordan.biz. We are working to make it a great Final Cut 
resource!
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Sigh...

My apologies for the delay in this month's issue. About midnight last 
night, I finally wrapped all the principle writing for my latest book for 
Lynda.com and Peachpit Press: Hands on Training for Final Cut Pro 5. 
Peachpit scheduled it for release in August, so I figured I better get it 
done. Getting it written took all my available time for the last couple of 
months. This issue of the newsletter was supposed to be the June issue. 
It just wasn't possible. Thanks for your patience.

Seminar Report: 
Supercharge Your Productivity with Final Cut Pro in Boston



Our Final Cut seminars in Chicago and Los Angeles were great. 98.5% of 
all attendees were delighted with the information and all but one want to 
attend another seminar.

So, our latest seminar is July 16 in Boston -- at the Doubletree Suites 
Hotel. This is the Saturday after MacWorld - Boston, so if you are going 
to the Expo, stay for one more day and take your editing skills to the 
next level.

This eight-hour seminar will give you productivity secrets that can make 
your editing fly! There are ten sessions in total, and the LA seminar 
considered these five to be the most valuable:

●     File Organization and media management
●     Answers to audience questions
●     Solving output problems
●     Editing Power Tips
●     Working with Multiclips
●     New features in Final Cut Pro 5

Registration is $195 and we only have 
50 seats available, so when those are filled, the seminar is closed.

Larry's Guarantee

For those of you who haven't heard me teach, I've decided to put 
my money where my mouth is. I'm so confident that you'll 
discover Final Cut techniques that will benefit you immediately 
that all my seminars are FULLY 100% guaranteed. If you are 
not satisfied, for any reason, let me know and I'll refund your 
registration fee.

See you there!

Looking for Seminar Partners

I've had a lot of requests to bring my seminars to Europe and Australia 
-- which we would love to do. So, we are looking for seminar partners to 
help us with location planning and marketing. Our current plans call for 
events in London and Sydney, ideally in the fall.

If your organization would be interested in working with us, please 
contact us for more details: seminars@larryjordan.biz

[ go to top ]

New Polls -- Tiger, FCP 5 and FCP HD

I have two new polls in need of your opinions.

http://www.larryjordan.biz/contact/index.html


The first poll asks whether you are having problems running 
FCP 5 on either 10.3.9 or Tiger. I want to know whether 
things are running smoothly or not for you. There's a lot of 
conjecture, I'd like to get closer to the facts.

The second poll asks whether you are having problems 
running FCP HD on either 10.3.9 or Tiger. There have been a 
lot of reported problems and I'm trying to see how extensive 
these issues may be.

Poll results are displayed immediately after voting, or by going to my 
home page. Once you vote, the polls always show you current results. 
Based upon voting so far, I think you will find the poll results interesting.

Your responses to these monthly polls are extremely helpful. They help 
me determine what material to put in my books, seminars, training, and 
web site. I use them constantly and I'm grateful that you take the time 
to complete them.

Click to see past survey results: http://www.larryjordan.biz/surveys.html

[ go to top ]

Upgrading to FCP 5 -- Revisited

Well, we've had over a month with FCP 5 in the market and I promised 
to keep you informed about what I've learned. 

The Executive Summary

●     I think Final Cut Pro 5 is as stable and effective on OS X 10.3.9 as FCP 
HD.

●     I think Tiger (OS X 10.4.1) is not stable, nor should it be used for 
serious production unless you have no alternative.

●     Running Final Cut Pro HD on 10.3.9 is fine, provided you do not upgrade 
to QuickTime 7.

●     I think Final Cut Pro HD should not be used on Tiger.
●     I think Final Cut Pro HD should not be used with QuickTime 7.

More Details

A couple of weeks ago, I sent emails to ten friends, trainers, forum 
masters, vendors, and FCP gurus asking their opinion of the new 
operating system and Final Cut. What I failed to do was ask their 
permission to use their names along with their comments in this 
newsletter. And, as these folks make their living selling their opinions, 
I've decided to summarize their comments without attribution. (Sigh..., 
next time I'll remember to ask.)

First, and most important, there is general agreement to NEVER upgrade 

http://www.larryjordan.biz/surveys.html


in the middle of a project. Finish your project first, then upgrade. I have 
several very unhappy editors who ignored this advice and are now sadly 
wiser.

Of the nine people that responded to my request, all but one said that 
running FCP 5 on OS 10.3.9 was stable. Only one commented that he 
had run into problems with FireWire and capturing.

As one wrote: "I have not seen any stability problems with FCP 5. There 
are some bugs that are rearing their heads, some things that have been 
broken, other things that have been fixed. I guess it's always a trade-
off."

Another wrote: "I concur. FCP 5 seems as stable on OS 10.3.9 as FCP 
HD and seems to be one of Apple's better .0 releases for FCP. Unlike FCP 
4, this one seems to have been ready for release."

A much bigger issue is running FCP HD under OS 10.3.9. Here the key 
factor is QuickTime 7. If at all possible, don't upgrade to QT 7 if you are 
running FCP HD. There are just too many reported problems for me to 
be comfortable recommending this solution.

If you have installed QT 7, and are having problems, go to Apple's 
website and download the QT 6.5 reinstaller. Use it to remove QT 7 and 
re-install QT 6.5. This has solved a number of problems for a variety of 
clients.

All third-party capture cards (except Cinewave) now support OS X 
10.3.9 so making the move to FCP 5 should be OK.

SoundTrack Pro, though, is a different issue. As one wrote: "FCP 5's 
biggest problem seems to be SoundTrack Pro, which is so broken it's 
kind of sad."

And, again, "we are waiting for a dot rev of Soundtrack Pro, and, 
perhaps of FCP 5, before we would advise our facility clients to move 
forward. Then, again, our opinions are extremely conservative."

Things change with Tiger, however. 

Though one person wrote: "I've been running FCP 5 and Tiger since 
before NAB and it has been extremely stable. I've been very happy with 
it." Other chimed in on the opposite side: "I would still recommend 
against running FCP 5 on Tiger. Perhaps things will improve with an 
upgrade to 10.4.2, but until then, I'd be cautious." 

Another said, "Tiger has issues, but none fatal that I've found."

A capture card vendor wrote: "I'd say you are OK with 10.4.1," but 
make sure you are running the latest versions of all your software. 
Especially, "make sure you run the X-RAID software update to get the 
proper drive performance." A good safety net is to run a dual-boot 
setup, where you can easily revert back to the earlier version of the OS 
and FCP in the event of major problems.

The people that are in a hard position are folks that just bought a new 



computer which comes with OS X 10.4.1 pre-installed and no way to 
downgrade to OS 10.3.9. If you are in this position, as a number of my 
clients are, don't panic. I'm seeing a variety of bugs which I believe are 
due to 10.4.1 problems. Apple is already working on a significant bug-fix 
to Tiger, which will be a free upgrade to 10.4.2. This should make Tiger 
a lot more useable for all of us.

HOWEVER, when 10.4.2 is released DON'T UPGRADE! Wait a week or 
so and make sure it works OK. It is better to wait a week and have 
everything work great than to update immediately, only to discover 
things got much worse.

Patience is a virtue -- though that's easier for me to say than to do.

One last comment. I have two principal computers that I use constantly: 
a laptop for training and a G-5 for editing and production. My laptop is 
running FCP 5 and OS X 10.3.9. My G-5 is running FCP HD and OS 
10.3.2. I've decided that I'm satisfied with the reliability of 10.3.9 that 
I'm upgrading my main production system to FCP 5 on 10.3.9. And, 
when 10.4.2 comes out, I'll upgrade my laptop to FCP 5 on 10.4.2.

FCP 5 isn't perfect, but it looks safe enough to use.

I'm always interested in your comments. Let me know your opinions and 
I'll share them with the everyone.

- - -

Update: Based on several emails, I want to clarify two points:

●     FCP 5 requires QuickTime 7
●     Tiger requires QuickTime 7

So, in these two cases, be sure you are running the latest version of 
QuickTime, which is version 7.01 as of July 4, when this was updated.

Also, there are a number of reported problems when people down-grade 
from QT 7 to QT 6.5. If your system is working OK with FCP HD and 
QuickTime 7, then leave it alone. Only consider down-grading to QT 6.5 
if you have problems.

[ go to top ]

Tutorial - Setting FCP 5 Preferences

As we move into Final Cut 5, I get lots of questions about how to 
configureyour system. So this is a tutorial that explains new FCP 5 
preference settings and gives you the settings I use on my system. (This 
does not cover all preferences, for that you'll need to read the manual, 
just those that are either new or really important.)

There are three groups of preferences in Final Cut: 

1.  Those that configure Final Cut to your audio and video 



gear.
2.  Those that configure Final Cut to your computer system
3.  Those that configure Final Cut to you.

And, when I'm configuring a system, I work in that order. All the screen 
shots show the settings I use on my system. And, with few exceptions, 
these screens are the same for both FCP HD and FCP 5.

Configure your audio/video gear

If you are using DV, Final Cut Pro > Easy Setup should be your first 
choice.

Select DV - NTSC if you are in the US, or other NTSC country. Select 
DV - PAL if you are working with PAL format video. Notice that new with 
FCP 5 are selections for the various sizes of HDV. Again, HDV-PAL users 
should select 1080i50, and HDV-NTSC users should select 1080i60. 
720p runs only at 30 frames per second.



If you need to change individual A/V setups, select Final Cut Pro > 
Audio/Video settings. 

My general recommendation is to leave these alone if you are new to 
FCP. The default settings are usually OK. However, the two settings at 
the bottom are important. Be sure you are monitoring your audio and 
video from the same place.

If you are watching your video on your computer screen, where Video 
Playback is set to either None or Digital Cinema Desktop Preview, 
then be sure you are listening to Built-in Audio.

If you are watching your video via FireWire on an external monitor, then 
be sure you are listening to your audio via FireWire DV. 

If you watch your video via FireWire and listen to your audio on your 
built-in computer speakers, your audio and video will be 3-9 frames out 
of sync. This is due to the delays caused by converting to and from DV. 
This delay will drive you nuts, so, remember to always watch and listen 
to your audio and video from the same point: both on an external 
monitor or both on the computer, never mixed.

Configure your computer system



Final Cut Pro > System Settings > Scratch disk tab is, without a 
doubt, the most important preference screen in Final Cut. If this is not 
setup properly, you'll never get the performance or reliability you need 
from Final Cut.

Here's what I do: I create a folder on each drive I want to use to store 
media (I never store media on my boot disk). I name the folder Final 
Cut Pro Documents. Then, I "point" my scratch disk to this folder using 
the Set command at the top of this screen.

If I have more than one media drive, I create one Final Cut Pro 
Documents folder on each drive.

Final Cut automatically records media to the drive that's the emptiest. 
This means your media will be stored fairly evenly across all your media 
drives. This decreases the playback demands on each drive.

Here are some other tips to use with this dialog box:

1.  You should always use a second hard drive (either 
internal or external) to store all your media. The drive 
that holds your operating system and applications will 
be too busy doing other tasks to playback media fast 
enough to edit.

2.  I used to capture media to one drive and render files to 
a different drive. But, now, I capture everything 
everywhere. Final Cut can easily keep track of it, and it 
simplifies my setup.

3.  Never capture audio and video to separate drives.
4.  Set the minimum free space setting to 10,000. This 

makes sure your hard disks don't get too full, which 
slows down both recording and playback.

5.  While it isn't necessary to store your Waveform, 
Thumbnail and Autosave files to the second disk, I like 
doing it for the symmetry of it. It keeps everything in 
one place and decreases the load on my boot disk.



6.  I am NOT a fan of Capture Now -- I find it to be 
inaccurate and unreliable in FCP HD. However, if you 
are using it, be sure to check the bottom box and give 
it a value equal to your longest tape. That way, FCP 
won't capture black when a tape runs out and you've 
left the room for a meeting.

The Search Folders tab is new with FCP 5. This allows you to specify 
where FCP will search when it needs to reconnect new files. This is a 
very useful setting because it makes finding and reconnecting media 
much faster. 

If you created the Final Cut Pro Documents folder that I just mentioned, 
then set a Search Folder for each occurrence of Final Cut Pro Documents 
on each of your media drives. In other words, if you have one drive, 
there would be one line listed. If you have two drives, there would be 
two lines, and so on.

Here, you see I've set a search folder to the Final Cut Pro Documents 
folder on my second drive.

System Settings > Playback Control tab was revised for FCP 5. New 
in this version is Dynamic RT, which allows Final Cut to vary playback 
quality during editing based on the complexity of your effect and the 
speed of your system. Dynamic RT is what Unlimited RT should have 
been, because it dramatically decreases the time you need to spend 
rendering during editing.



With FCP HD, I set RT to Safe, because for me this works the best. 
With FCP 5, I set RT to Unlimited, with both Video Quality and Frame 
Rate set to Dynamic. This allows me to see a wide range of effects in 
real-time, without waiting for rendering.

I still need to render before final output, but, now, I don't need to render 
nearly as much during editing.

The rest of the settings in this dialog are system defaults, which I leave 
alone.

The System Settings > External Editors tab caused a lot of confusion 
in FCP HD, because it changed depending upon whether you bought the 
retail package or the upgrade. 

This dialog allows you to configure FCP to open an external application to 
edit a clip in the Browser or Timeline. I've found this to be a tremendous 
timesaver. However, in this version, LiveType is hard-wired so that 
control-clicking on a LiveType clip automatically opens Livetype, so you 
don't need to set the preferences here.

In my case, I set this to open PhotoShop to edit my still files and 
Soundtrack for my audio files.

Configure Final Cut for you



 

Select the Final Cut Pro > User Preferences > General tab to 
configure FCP to your method of working.

First, I like all the default checkbox settings. So, in general, I leave them 
alone.

Limit Real-time video to # MB/Second is new with FCP 5. Apple 
writes, "Final Cut uses this number to limit how many video streams can 
playback from your scratch disk in real time. This is useful when ... you 
have a scratch disk with a limited data rate" such as a Firewire drive.

The key benefit is that this attempts to reduce the number of times you 
see the dreaded "dropped frames" error message. 

For instance, if you create an effect that requires a lot of clips playing 
back at once from your hard disk, if this is not turned on, Final Cut will 
attempt to play your effect, but fail, because your hard disk isn't fast 
enough.

If this is turned on and set to about the data transfer rate of your hard 
disk, Final Cut will realize your effect exceeds the ability of your hard 
disk, so it puts a red render bar over the effect, requiring you to render 
it. 

Because rendered effects always play smoothly, this setting is very 
useful in improving performance when you are using slower FireWire 
drives, or XSAN volumes.

I use a setting of 22 for an external FireWire drive on my G-4 laptop, 
and 36 for an external SATA drive on my G-5. If you have a RAID, you 
can leave this alone. 

Here are the other changes I make to this screen:

1.  I set Undo to 25 -- this take a lot of RAM, so if you 
have 1 GB of RAM or less, don't change this.

2.  I tend to work on one project at a time, so I leave Open 
Last Project" checked. If I'm always switching between 
projects, I leave this off.

3.  I increase the size of text in the Browser and Timeline 
to Medium (this is FCP 5 only)

4.  I decrease the Auto-Render setting to 15. I'll write an 
article about this feature in next month's issue.

5.  I change the defaults in the Auto-Save Vault so that it 
saves sooner and keeps fewer backups. 



There's one last preference screen I want to mention -- the User 
Preferences > Editing tab. 

Here, I change the default Preview pre-roll and post-roll to 4:00 and 
3:00, respectively.

Why? Because when I want to preview an edit, I press the backslash key 
( \ ). The Playhead backs up the amount of seconds specified in the Pre-
roll, plays through the edit the number of seconds specified in the Post-
roll, then stops and resets back to its original position.

I use this preview method constantly -- and have never liked the default 
settings. So, I changed them and, now, you can too.

That's an overview of the preference settings in FCP 5 and how I suggest 
you set them up. I've found these to be reliable with excellent 
performance characteristics. 

You can keep this as a record in case your system gets trashed and you 
need to reset them yourself.

[ go to top ]

Tips on Working with HDV

There's no doubt that HDV has made an impact on our industry. 
However, HDV is not DV. In fact, there are significant differences to 
working with HDV, especially when compared to the video we've 
traditionally worked with.

The big issue is that HDV uses a compression system called Long-GOP 
MPEG-2. What this means in English is that a group of images, 15 in this 
case, are all grouped together and treated as a single frame (a GOP, or 
Group of Pictures). So, instead of one picture per frame, which we are 
used to in DV and film, we have 15 pictures to one frame. This makes 
for really great compression, but it's almost impossible to edit. The 
reason is that MPEG was designed to only allow edits at the start of one 
of these Groups of Pictures. This boundary is called an "I-frame." 

 



DVD's use a similar compression structure, which is why it is often 
difficult to edit video which has been compressed into MPEG-2 for DVD 
use. 

However, Apple has figured out a way to edit HDV natively, without 
converting it into a different file format. However, this native editing is 
not without trade-offs. So, here is a list of the ways HDV is not the same 
as DV:

1.  HDV needs serious CPU power. You need a minimum 1 
GHz processor and 1 GB RAM.

2.  You can’t monitor HDV thru FireWire while editing, you 
can only watch HDV on your computer screen.

3.  You can only output to tape using Print to Video. You 
can't Edit to Tape.

4.  There is no HD-SDI deck for high-end output.
5.  You can't up-rez HDV to HDCAM.
6.  The native resolution of HDV is 1440 x 1080. However, 

HDV only outputs at 1920 x 1080 interlaced using line-
doubling, or 1280 x 720 progressive using down-
sampling.

7.  HDV takes significantly longer to render than DV, 
because the image size is four times larger.

8.  FCP only renders HDV frames that changed during 
editing. A frame is changed if an edit occurs anywhere 
within the GOP, except on the I-frame boundary, or if 
you've applied an effect or transition.

9.  There are timecode accuracy and frame-rate issues in 
capturing and outputting HDV.

10.  When capturing HDV, you can't control the deck or 
camera as precisely as you can with DV. So, in general, 
capture with larger handles than you would normally 
use.

11.  HDV only supports 2 channels of audio in or out/
12.  HDV is already in MPEG form, so you don't need to 

compress it again.
13.  If you want to export an HDV sequence to include on a 

DVD, be sure to export it using File > Export > 
QuickTime Movie and make it SELF-contained. 
Reconform all I-frames to match the HDV compression 
structure

To help with some of these problems, Apple has created an Intermediate 
codec which converts HDV from it's long-GOP MPEG-2 structure into a 
frame-based video format. There are several benefits to using the 
Intermediate codec and one disadvantage:

1.  You can monitor editing using the intermediate codec 
thru FireWire.

2.  The intermediate codec is better for editing on slower 
computers.

3.  The intermediate codec creates files that are four-times 
larger than native HDV.

4.  There are reported quality issues with the intermediate 
codec.

5.  Converting between HDV and the intermediate codec is 
not loss-less, however, Apple says it's testing shows 



that the conversion quality is better than competitive 
products.

[ go to top ]

Tips from the Classroom

Every month I learn something new while teaching Final Cut. Here are 
the latest tips discovered by my students. These should work the same 
in both FCP HD and FCP 5.

Cathleen

Set an In and an Out in the Timeline. Press Shift+X to do a 
Ripple Delete from the In to the Out.

Marlin

When I copy a clip from the Viewer to the Timeline (Edit > 
Copy and Edit > Paste) the Patch Panel determines to 
which track the clip gets pasted. 

When I copy a clip from the Timeline to elsewhere on the 
Timeline, the AutoSelectbuttons to the right of the track 
locks, determine the track where the clip gets pasted.

Antonio

Option++ (meaning hold down the Option and the plus 
keys) and Option+- (Option and minus keys) zooms the 
Timeline, regardless of whether it is selected or not.

Command++ or Command+- zooms whatever window is 
selected (Timeline, Viewer, or Canvas).

[ go to top ] 

New FCP Filters

Mattias Sandström has been creating Final Cut filters for a long time, I, 
um, just never knew it until recently.

If you are looking for a wide range of plug-in filters for Final Cut, check 
out his website:

Too Much Too Soon: http://www.mattias.nu/plugins/

There are a lot of color correction and technical improvement filters, 
such as:

●     Smart Anamorphic converts between 16:9 and 4:3
●     Black Restore
●     Fast Deinterlace

http://www.mattias.nu/plugins/


●     Chroma Resampler
●     Noise reduction

Best of all, Mattias only asks for a donation. (Which is more than fair, 
given the amount of work that goes into creating these. If you decide to 
use his filters, please respect his time and send him some money.)

[ go to top ]

Compressor Tutorial

Roy Close, with the Harvester Baptist Mission, sent me a PDF file of a 
tutorial he wrote on how to improve video and audio quality using 
Compressor I (the version shipping with FCP HD). 

If you are new to the whole field of compression, this offers a cook-book 
approach to improving the quality of your work. (If you've been 
compressing since before MPEG, this will be too basic for you.) 

Remember, the only time you need to use Compressor is when you need 
to prepare a file to move into DVD Studio Pro, iDVD handles 
compression internally.

To get a copy of this free report, send Roy an email to: 
glenroyhbm@pineland.netYou'll find the step-by-step instructions useful 
and, as I said, the report is free.

[ go to top ]

Tutorial: Multi-clip Trimming

This tutorial grew out of a question in one of my classes: How can I trim 
several clips at the same time?

His specific request came when we were talking about the need, for 
instance in a documentary, to trim clips on several tracks at once. There 
are a variety of ways to do this, so here are some examples.

Multi-track Rippling

This technique is a good choice when you need to ripple the In, or Out, 
of a talking head, while still keeping the B-roll in sync. A Ripple adjusts 
the In or the Out, but not both. I use this to adjust the timing or 
placement of a clip.

mailto:glenroyhbm@pineland.net?subject=Compressor%20report


1.  Turn Snapping off (press N)
2.  Select the Ripple tool (press RR)
3.  Click the In, or Out, of the linked clip on V1 to select 

it. In this example, I used the In.
4.  Hold the Command key and click the In of the clip on 

V2 to select it.
5.  Drag the Ripple tool to trim your edit. This adjusts the 

audio and video In of all selected cilps at once.

Multi-track Rolling

This technique is a good choice when you need to adjust the Out of the 
first clip and the In of the second clip at the same time. Most often, I use 
this to adjust the timing of when an edit point occurs.

1.  Turn Snapping off (press N)
2.  Select the Roll tool (press R)
3.  Click the edit point to select both the In and the Out of 

the linked clip on V1.
4.  Hold the Command key and click the edit point of the 

clip on V2. Again, because the audio and video are 
linked, both the audio and video edit points are selected.

5.  Drag the Roll tool to adjust the timing of where the edit 
point occurs.

Rolling Just Audio, or Just Video



You can't ripple trim just the audio or the video, it would throw 
everything out of sync, so Final Cut prevents it. (If you do find yourself 
confronting a whole flock of red "out-of-sync" flags, Control+click on a 
red flag and select Move Into Sync.)

However, you can Roll just the audio or video. In fact, this is the 
trimming technique that I use the most. This allows me to change 
picture without affecting audio, or tweak the audio without changing 
video. However, doing this for clips on multiple tracks is a bit tricky, so 
follow closely.

1.  Turn Snapping off (press N)

 

2.  Select the Edit Selection tool (press G). This allows you 
to easily select edit points across multiple tracks.

 

3.  Hold the Option key and drag the Edit Selection tool 
around the edits you want to change, in this case, just 
the audio. The Option key allows you to select just the 
audio, or just the video, of a linked clip.

4.  Select the Roll tool (type R).
5.  Drag the Roll tool to adjust your edit points.



This technique works equally well at adjusting video, audio, or both. The 
key is using the Option key with the Edit Selection tool.

[ go to top ]

Technique - Using Markers in a Multiclip

I got a call late in the evening from a prime-time network show asking 
about how to use markers in a Multiclip. They weren't working the way 
the editor was expecting. So, I did some research and here's what I 
found.

Multiclips are new with Final Cut Pro 5 and allow you to see multiple 
camera angles at the same time. Apple did a really great job in 
implementing this feature and I'm looking forward to writing a tutorial 
on how it works for a future issue. What a multiclip does is combine a 
series of related shots into a single new clip where you can see all the 
images at once.

However, the editor that called me was puzzled, because what he 
wanted to do was add a marker to a source clip and have that marker 
travel wherever the source clip went. But that's not how multiclips work.

A multiclip is a totally different clip from the source clips it contains. So, 
any markers in a source clip are ignored when you create a multiclip.

However, any markers you put in the multiclip itself, by typing M in the 
Viewer, are retained as clip markers when that multiclip is edited to the 
Timeline. This allows you to indicate particular shots, or music beats, or 
whatever else you want to flag when the multiclip is edited into your 
sequence.

Any clip markers in a multiclip in the Timeline show up in the Viewer 
when the multiclip is loaded back into the Viewer.

Markers are a great way to flag specific locations in a clip, or the 
timeline. I use them constantly -- they are like my yellow sticky notes in 
Final Cut Pro. So, to summarize:

●     Markers existing in source clips are not added into a multiclip when 
the multiclip is created

●     You can't put a marker in a multiclip angle, only in the multiclip 
itself

●     Markers in a multiclip appear on the timeline as clip markers
●     Timeline markers for a sequence containing a multiclip behave 

exactly the same as markers for any other clip

[ go to top ]

Reader Mail

Well, the summer has started, because the mail has significantly 



decreased. Still, there are a number of good questions, so let's get 
started.

Duane Codrington writes:

Love your work -  I think I must have introduced almost 40 
people to your website. Here's a topic which I would really 
like to see covered in a future article if possible:

I am shooting Sony HDV side by side with a Sony PD 170 set 
to 16:9.

1.  In  FCP 5, how do I work with HDV and DVCAM footage 
in the same sequence, or what is my best alternative?

2.  How do I work with anamorphic and squeezed 16:9 
footage in the same sequence?

Larry replies: Wow! That's like mixing oranges and kumquats. The short 
answer is that something has to render. But, before we get to that point, 
you need to make a decision: is your sequence DV or HDV. You can 
output one or the other, but not both.

In researching the answer to your question, I loaded DV and HDV 
footage into the same DV sequence. The DV played normally and the 
HDV needed to render. However, this meant that the HDV was down-
sampled to a DV image size.

To try to match the native 16:9 with DV's 4:3, I created a new sequence 
and turned on the Anamorphic check box in Sequence > Settings. I 
did this BEFORE adding any video to the sequence. Then, adding HDV 
looked normal. However, DV was squeezed into an anamorphic shape, 
which distorted the image.

Hmmm.... this was no good. Trash that idea.

So, I then created a new DV 4:3 sequence and added my DV clips and 
HDV clips as before. Then, I selected all the DV clips and applied an 
Effects > Video Filter > Video > Wide Screen filter and set it 1.78:1 
(which is 16:9).

Now, everything looked fine playing back.

IF, on the other hand, you want to put DV into an HDV sequence, then 
you'll need to create a new HDV sequence, add your HDV and DV 
footage as before, then go to the Motion tab and scale your DV footage 
to 300%.

When you use an HDV sequence, your 16:9 aspect ratio is handled 
automatically within the sequence.



- - -

King Dexter wrote in:

I was having a problem with Final Cut not displaying images 
properly. After talking with an especially well-informed Apple 
Tech, it was, as you suspected, a QuickTime 7 glitch which 
Apple declares as "Random." Sometimes, says Apple, 
QuickTime causes a "partial performance" issue where some 
things still work and others don't. As you know, I had firewire 
device control but no video on my external monitor and no 
preview in the log & capture window....

The fix:

1.  Go to HD>Library>Receipts and trash anything that 
says QuickTime with a bunch of numbers after it (i.e. 
QuickTime65.pkg, QuickTime70.pkg, QuickTime701.
pkg, QuickTime652.pkg, etc.)

2.  Go to the Apple web site. Click the QuickTime tab and 
download the Free, QuickTime 7 and install it. It is the 
7.0.1 version and will recognize your pro key if you 
have one.

3.  Re-launch FCP5 and you should be good to go.

Apple said this should be a one-time fix. It should hold for 
good. This rep said they are not exactly sure why this 
happens on a random basis although the senior systems 
people probably have a better idea than he. 

Interesting that he said it probably won't be a specific fix in a 
future version of QT but couldn't be sure. Also said that this 
seems only to pertain to Quicktime and Tiger. Also, this issue 
presumably hit (or will hit) the Apple Knowledge base as we 
speak.

Larry replies: Yup, sounds pretty random to me. Thanks for sending 
back the info.

- - -

Tony Luzzi wrote:

As you know, FCP 5 supports external control surfaces, which 
allow you to mix audio on something more like a mixer than 
a computer screen. However, I was having a problem using a 
Tascam control surface. It would start working, then quit for 
no apparent reason.

After discussions with both Apple and Tascam, we discovered 
that in order to use a Tascam control surface with FCP 5, the 
Final Cut mixer window must be open.

Now that I've got this Tascam mixer thing working, it is very 
cool because you have 3 modes:



1.  Monitor MIX -- That allows me to use a standard type 
mixer with feeds my decks to the AJA I/O. It has 8 
inputs-4 can be use as eith mike or line. So i can use it 
to record V/O's too.

2.  Computer -- It allows me to mixer in FCP with its 
control surface----with 4 banks to control 8 tracks at a 
time inside FCP 5.

3.  Midi Control -- Not sure its use yet-been too busy 
figuring out 1 and 2.

All this for $799.00

Larry replies: Tony, this is a known issue with Tascam control surfaces 
and your solution is perfect. Also, if the FCP mixer gets in your way, just 
minimize it.

- - -

Torrey Loomis, President of Silverado Systems, sent out an email with 
the following information:

Just a quick update for those wondering how much RAM to 
get in a new Mac. Bare Feats has a great overview of why 
maxing out your RAM on a Tiger-equipped Mac makes sense 
with new Apple and Adobe apps:

Running Motion 1.0 under Tiger, loaded and rendered RAM 
PREVIEWS of 4 templates. Motion gobbled up 2.4GB in the 
process. (Same result under Panther.)

Running Motion 2.0 under Tiger, loaded and rendered RAM 
Previews of 4 templates. Motion 2.0 grabbed only 287MB but 
total memory use of Tiger "pounced" to 5.5GB. So just as 
with Photoshop CS 2, the OS is handling the caching instead 
of the app. And maxing out your memory to 8GB makes 
more sense than ever, now that Tiger is "on the loose."

Larry replies: Final Cut does not take advantage of any memory above 4 
GB. So, if FCP is your main app, don't bother with the extra memory. 
Motion, however, can take advantage of up to 8 GB of RAM. 

For my purposes, 2.5 GB of RAM works fine for what I do. The additional 
RAM in Motion allows you to work with longer projects. However, most 
effects projects tend to be short, so I consider it a toss-up whether to 
recommend getting the extra RAM.

Motion requires two types of RAM -- system RAM and video card RAM. 
The system RAM controls how much of your project is kept in memory at 
one time. The video card RAM determines how many objects can move 
around the screen at once in real time. If I were spending the money, I'd 
spend it on getting as much video RAM as possible.

- - -

Send in your comments and questions -- sharing your ideas, questions 
and discoveries helps us all to learn.



In closing...

If you are near Boston for MacWorld, please consider spending a day 
improving your Final Cut skills by attending my seminar.

And don't forget this month's polls:

Wrap-Up 

Well, that's it for this edition of the newsletter. Let me know what you 
think, and tell your friends to subscribe. I love reading your comments 
and sharing them with others. 

Or, send in some ideas of what you'd like us to talk about.

Even better, send in some tips of your own. I'm happy to publish 
everyone's ideas. That way, we all learn!

Thanks -- and have fun editing!

Larry

[ Go to top. ]
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your 
friends to sign up at www.larryjordan.biz.

To unsubscribe, simply send me an email and I'll drop you from the list. This 
list is not sold, rented, or bartered. The only person who knows you are on this 
list is me.
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The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please 
use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third 
party. All trademarks are the property of their respective owners and are 
mentioned here for editorial purposes only.

Text copyright 2005 by Larry Jordan. All rights reserved. This newsletter may 
not be reproduced or published in any way, in whole or in part, without specific 
written (or emailed) permission from the author. 

Links to my website home page, or articles, are welcome and don't require 
prior permission. 
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